
© 2017 ACP, Inc.
225  49th Avenue Drive SW
Cedar Rapids, Iowa 52404

Part No. 20218501  
ACP Programming App  

Updated 10/2017

Page 1 of 6

ACP Programming App version is subject to change.  
Please use most recent release when available.  
For best results, use in conjunction with the latest oven firmware.  
To download firmware updates and installation instructions, please visit acpsolutions.com/oven-programming/.

Download and Install:
1. Open an internet browser and go to acpsolutions.com/oven-programming/.  
2. Select the appropriate ACP Programming Application download.  

(Windows Download or Mac OS Download) Your download will begin. 
3. Open and install the downloaded ACP Programming Application:

• Windows: 
i. Locate the downloaded file.
ii. Click to launch the extracted file.
iii. Follow prompts to install the application in your C:\Program Files folder

• Mac OS: 
i. Locate the downloaded file.
ii. Drag and drop the file into your Applications folder
iii. Follow prompts to install the application

ACP Programming Application 
User Guide │Touchscreen Ovens
Use the ACP Programming Application to create 
and organize menu item information from your computer.

Getting Started:
1. Launch the application

• Windows: Open “ACP Remote Programming Interface” from your Program Files, or the Start Menu shortcut
• Mac OS: Open the “ACP_Application.app” file

2. Start a New menu from scratch (a), or Open an existing menu (b):
a. Create New Menu: 

i. Click “File”, then “New.” 
ii. Select the appropriate model

b. Open Existing Menu: 
i. Select “File,” then “Open.” 
ii. Navigate to the location of your menu file and open it. 

2a 2b

http://acpsolutions.com/oven-programming/
http://acpsolutions.com/oven-programming/
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Change User Options:
1. To change the default language, select from options in the top-right drop down menu.
2. Click on the User Options tab to access a variety of customizable settings.

Note: The temperature set in the User Options section will be the default when creating a new menu item

Note: The default logo for the standby screen is the ACP, Inc. logo. Customize it and add your own logo by selecting the  
“Add Logo to Startup” button.

Note: If “PIN code required” option is enabled, the chosen PIN must be a 4-digit numeric PIN.

Customize Startup Screen Logo
1. Resize desired image to 400 x 400 pixels and save in PNG format. 
2. In the User Options tab, click Add Logo to Startup
3. Click on the folder icon and navigate to the location of the image. Select Open. 
4. Close “Custom Logo” window to save changes.
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Create a New Recipe Tab
1. Click on the Tabs drop down menu and select the number of tabs desired.
2. To customize each tab appearance, click on the tab.
3. Select one of the following options:

a.  Type your custom text or
b.  Select an icon

4. Select the green check mark to save.

Create a New Recipe Folder
1. Select the Menu tab. 
2. Click on New Folder 
3. Edit folder name and appearance in the panel on the right.  

To delete a folder, click the orange trash can icon.
4. Drag and drop recipes into folder.  

Double click on the folder icon to access the contents. 

1 2

Organizing Menus:
You may add and organize recipe information by creating new recipes, folders and tabs.  
See the following pages for more information.

Content Example: 
Tab 1: Lunch Menu Tab 2: Dinner Menu
 Folder A: Sandwiches  Folder A: Pizza
  Recipe 1: Reuben Panini   Recipe 1: Pepperoni Pizza 
  Recipe 2: Muffuletta Panini   Recipe 2: Cheese Pizza
 Folder B: Sides  Folder B: Seafood
  Recipe 1: Fries   Recipe 1: Salmon
  Recipe 2: Roasted Veggies   Recipe 2: Shrimp

To download and view example menus, please visit  
acpsolutions.com/oven-programming/#menu-examples

http://acpsolutions.com/oven-programming/#menu-examples
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Customize Recipe and Folder Images
1. Click on the image icon to chose an image for the recipe or folder. 
2. Select one of the following options:

a. “Pictures” tab to view and select from an assortment of stock images. 
b. “Icons” tab view and select from an assortment from graphic icons
c. “Load Image” tab to upload a custom image for the recipe.

Load an Image*:
1. Resize desired image to 380 x 223 pixels and save as PNG format.  

Please note that the bottom 64 pixels will be covered by text.
2. Select the folder icon to upload the custom image. (see figure 2c below)
3. Navigate to the location of the image and select “Open.” 
4. Select the green check mark to save.

*For custom image uploads only

2a 2b 2c

1

Create a New Recipe:
1. Select the Menu tab.
2. Click on New Recipe
3. Edit recipe name, settings, and appearance in the panel on the right.  

To delete a recipe, click the orange trash can icon.

1

2 3
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Edit an Existing Folder
1. Select “File,” then “Open.” Navigate to the location of your menu file and open it.

2. Click on the folder to edit the color, icon, image, name, etc.
3. To delete a folder, select the orange garbage can icon.
4. To save changes and create a new updated file, select “File” then “Save As.”

Edit an Existing Recipe
1. Open the ACP Programming Application from your computer.
2. Select “File,” then “Open.” Navigate to the location of your menu file and open it.

3. Double-click to open the folder containing the recipe.
4. Click on a recipe to edit the recipe name, image or cook settings.
5. To delete a recipe, select the orange garbage can icon.
6. To save changes and create a new updated file, select “File” then “Save As.”

Create a New Recipe:
1. Select the Menu tab.
2. Click on New Recipe
3. Edit recipe name, settings, and appearance in the panel on the right.  

To delete a recipe, click the orange trash can icon.
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Save Menu Information
For touchscreen models, files may be transferred via USB, WiFi or Ethernet connection.  
See below for best practices for each method of transfer: 

USB
1. Select “File”, then “Save As.”
2. Navigate to the USB flash drive. 
3. Specify a File Name for the new menu. Click “Save.”
Note:  Files must saved to the root directory of USB flash drive (cannot be saved inside another folder). 

WiFi or Ethernet
1. Select “File”, then “Save As.”
2. Navigate to desired location. 
3. Specify a File Name for the new menu. Click “Save.” 

Understanding Menu File Formats

LEGACY VERSION IMPROVED VERSION

ACP Programming App Version
Windows: Desktop Release 34 Windows: 2017.08.22
Mac OS: MAC_release10_04_2016 Mac OS: 2017.08.22

Compatible Oven Firmware Versions ≤ 3.1.0 Versions > 3.1.1

Saved/Exported Menu File Format
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Via USB Flash Drive or

Via WiFi/Ethernet or

Do you have a .mxp menu file which you’d like to load onto an oven with an older firmware version?

 ● ACP strongly recommends updating the oven to the latest and greatest version of firmware.  
Visit acpsolutions.com/oven-programming/ to learn more and download .  

 ● If you choose to continue using the older version of firmware, you may revert .mxp files to the legacy 
format using the following method:

1. Rename the .mxp file: replace “.mxp” file extension with “.zip”
2. Extract or unzip the renamed file

http://acpsolutions.com/oven-programming/
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Aplicación de programación de ACP Versión sujeta a cambios.  
Utilice la versión más reciente cuando esté disponible.  
Para obtener mejores resultados, utilice junto con  la última versión de firmware del horno. Para descargar 
actualizaciones de firmware e instrucciones de instalación visite  acpsolutions.com/oven-programming/

Descargar e instalar:
1. Abra un navegador de Internet y vaya a acpsolutions.com/oven-programming/.  
2. Seleccione la descarga adecuada de la aplicación de programación de ACP.  

(Descarga para Windows o Descarga para Mac OS). Comenzará la descarga. 
3. Abra e instale la aplicación de programación de ACP descargada:

• Windows: 
i. Busque el archivo descargado.
ii. Haga clic para ejecutar el archivo extraído.
iii. Siga las instrucciones para instalar la aplicación en la carpeta C:\Program Files

• Mac OS: 
i. Busque el archivo descargado.
ii. Arrastre y suelte en la carpeta de aplicaciones
iii. Siga las instrucciones para instalar la aplicación

Aplicación de programación ACP 
Guía del usuario │Pantalla táctil
Utilice la aplicación de programación de ACP para crear y organizar la 
información del menú desde su computadora.

Para empezar:
1. Inicie la aplicación

• Windows: Abra “ACP Remote Programming Interface” (Interfaz de Programación Remota de ACP) desde los 
archivos de programa o el acceso directo del menú Inicio.

• Mac OS: Abra el archivo “ACP_Application.app”
2. Inicie un nuevo menú desde el principio (a), o abra un menú existente (b):

a. Cree un nuevo menú: 
i. Haga clic en “Archivo”, luego en “Nuevo”. 
ii. Seleccione el modelo correspondiente

b. Abra el menú existente: 
i. Seleccione el “Archivo”, luego “Abrir”. 
ii. Diríjase a la ubicación de su archivo de menú y ábralo

 

2a 2b* Aplicación de programación de ACP versión 3.0.1 vigente a partir de octubre de 2017. Versión sujeta a cambios.  
Utilice la versión más reciente cuando esté disponible.  
Para obtener mejores resultados, utilice junto con firmware de horno versión 6.1.1 o posterior.

http://acpsolutions.com/oven-programming/
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Cambiar las opciones del usuario:
1. Para cambiar el idioma predeterminado, seleccione las opciones en el menú desplegable superior derecho.
2. Haga clic en la pestaña Opciones del usuario para tener acceso a una variedad de configuraciones personalizables.

Nota: La temperatura configurada en la sección Opciones del usuario será la predeterminada al crear un nuevo elemento del 
menú

Nota: El logotipo predeterminado para la pantalla de espera es el logotipo de ACP, Inc. Personalícelo y agregue su propio logotipo 
al seleccionar “Agregar logotipo al botón de inicio“.

Nota: Si está habilitada la opción “Se requiere código de PIN”, el PIN elegido debe ser numérico y tener 4 dígitos.

Personalizar el logotipo de la pantalla de inicio
1. Cambie el tamaño de la imagen deseada a 400 x 400 píxeles y guarde en formato PNG. 
2. En la pestaña Opciones del usuario, haga clic en Agregar logotipo para iniciar
3. Haga clic en el icono de carpeta y navegue hasta la ubicación de la imagen. Seleccione abrir. 
4. Cierre la ventana “Logotipo personalizado” para guardar los cambios.

2

1

2

3

4



© 2017 ACP, Inc.
225  49th Avenue Drive SW
Cedar Rapids, Iowa 52404

Pieza N. º 20218501  
Aplicación de programación

Actualizada en 10/2017

Página 3 de 6

Crear una nueva pestaña de recetas
1. Haga clic en el menú desplegable Pestañas y seleccione el número de pestañas que desea.
2. Para personalizar la apariencia de cada pestaña, haga clic en la pestaña.
3. Seleccione una de las siguientes opciones:

a.  Escriba su texto personalizado  o
b.  Seleccione un icono

4. Seleccione la marca de verificación verde para guardar.

Crear una nueva carpeta de recetas
1. Seleccione la pestaña Menú. 
2. Haga clic en Nueva carpeta 
3. Edite el nombre de la carpeta y su apariencia en el panel de 

la derecha.  
Para eliminar una carpeta, haga clic en el icono de la 
papelera de reciclaje naranja.

4. Arrastre y suelte las recetas en la carpeta.  
Haga doble clic en el icono de la carpeta para acceder a los 
contenidos. 

1 2

Organización de menús:
Usted puede agregar y organizar información de recetas mediante la creación de recetas, carpetas y pestañas nuevas.  
Consulte las siguientes páginas para obtener más información.

Ejemplo de contenido:
Pestaña 1: Menú para el almuerzo Pestaña 2: Menú para la cena
 Carpeta A: Sándwiches  Carpeta A: Pizza
  Receta 1: Panini Reuben   Receta 1: Pizza de pepperoni 
  Receta 2: Panini Muffuletta   Receta 2: Pizza de queso
 Carpeta B: Guarniciones  Carpeta B: Mariscos
  Receta 1: Papas fritas   Receta 1: Salmón
  Receta 2: Verduras asadas   Receta 2: Camarón

Para descargar y ver los menús de ejemplo, visite 
acpsolutions.com/oven-programming/#menu-examples

http://acpsolutions.com/oven-programming/#menu-examples
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Personalizar imágenes de carpetas y recetas
1. Haga clic en el icono de la imagen para elegir una imagen para la receta o la carpeta. . 
2. Seleccione una de las siguientes opciones:

a. Pestaña “Imágenes” para ver y seleccionar de una variedad de imágenes de archivo. 
b. Pestaña “Iconos” para ver y seleccionar de una variedad de iconos gráficos
c. Pestaña “Cargar imagen” para subir una imagen personalizada para la receta.

Cargar una imagen *:
1. Cambie el tamaño de la imagen deseada a 380 x 223 píxeles y guarde en formato PNG .  

Tenga en cuenta que los 64 píxeles de la parte inferior se cubrirán con texto.
2. Seleccione el icono de la carpeta para cargar la imagen personalizada. (Ver figura 2C abajo)
3. Navegue a la ubicación de la imagen y seleccione “Abrir” 
4. Seleccione la marca de verificación verde para guardar.

*Solo para cargas de imágenes personalizadas

2a 2b 2c

1

Crear una nueva receta:
1. Seleccione la pestaña Menú.
2. Haga clic en Nueva receta
3. Edite el nombre de la receta, las configuraciones y la apariencia en el panel de la derecha.  

Para eliminar una receta, haga clic en el icono de la papelera de reciclaje naranja.

1
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Editar una carpeta existente
1. Seleccione el “Archivo”, luego “Abrir”. Diríjase a la ubicación de su archivo de menú y ábralo

2. Haga clic en la carpeta para editar el color, el icono, la imagen, el nombre, etc.
3. Para eliminar una carpeta, seleccione el icono de la papelera de reciclaje naranja.
4. Para guardar los cambios y crear un nuevo archivo actualizado, seleccione “Archivo” y luego “Guardar como”.

Editar una receta existente
1. Abra la aplicación de programación ACP desde su computadora.
2. Seleccione el “Archivo”, luego “Abrir”. Diríjase a la ubicación de su archivo de menú y ábralo.

3. Haga doble clic para abrir la carpeta que contiene la receta.
4. Haga clic en una receta para editar el nombre de la receta, la imagen o las configuraciones de cocción.
5. Para eliminar una receta, seleccione el icono de la papelera de reciclaje naranja.
6. Para guardar los cambios y crear un nuevo archivo actualizado, seleccione “Archivo” y luego “Guardar como”.

Crear una nueva receta:
1. Seleccione la pestaña Menú.
2. Haga clic en Nueva receta
3. Edite el nombre de la receta, las configuraciones y la apariencia en el panel de la derecha.  

Para eliminar una receta, haga clic en el icono de la papelera de reciclaje naranja.
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Guarde la información del menú
Para los modelos de pantalla táctil, los archivos se pueden transferir mediante conexión USB, WiFi o Ethernet.  
Vea a continuación las mejores prácticas para cada método de transferencia: 

USB
1. Seleccione “Archivo”, luego “Guardar como”.
2. Navegue a la unidad flash USB. 
3. Especifique un nombre de archivo para el nuevo menú. Haga clic en “Guardar”.
Nota:  Los archivos se deben guardar en el directorio raíz de la unidad flash USB (no se pueden guardar en otra carpeta). 

WiFi o Ethernet
1. Seleccione “Archivo”, luego “Guardar como”.
2. Navegue hasta la ubicación deseada. 
3. Especifique un nombre de archivo para el nuevo menú. Haga clic en “Guardar”.

Entender los formatos de archivo de menú

VERSIÓN ANTERIOR VERSIÓN MEJORADA
Versión de la aplicación de 
programación ACP

Windows: Edición para escritorio 34 Windows: 2017.08.22
Mac OS: MAC_release10_04_2016 Mac OS: 2017.08.22

Firmware de horno compatible Versiones ≤ 3.1.0 Versiones > 3.1.1

Formato de archivo de menú 
guardado/exportado
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A través de unidad flash 
USB

or

A través de WiFi/Ethernet or

¿Tiene un archivo de menú .mxp que desearía cargar en un horno con       
una versión anterior de firmware?

 ● ACP recomienda enérgicamente actualizar el horno a la última y mejor versión de firmware  
Visite  acpsolutions.com/oven-programming/  para obtener más información y hacer descargas.   

 ● Si opta por seguir usando la versión anterior de firmware, puede revertir los archivos .mxp al formato anterior 
mediante el siguiente método:

1. Renombre el archivo .mxp: reemplace la extensión del archivo “.mxp” por “.zip”
2. Extraiga o descomprima el archivo renombrado.

http://acpsolutions.com/oven-programming/
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La version de l’application de programmation ACP sujette à modification.  
Veuillez utiliser la version la plus récente disponible.  
Pour de meilleurs résultats, utilisez en conjonction avec la dernière version du firmware du four. Pour télécharger 
les mises à jour du firmware et les instructions d’installation, veuillez vous rendre sur acpsolutions.com/oven-
programming/

Téléchargement et installation :
1. Ouvrez un navigateur Web et rendez-vous sur acpsolutions.com/oven-programming/.  
2. Sélectionnez le téléchargement de l’application de programmation ACP approprié  

(Téléchargement pour Windows ou Téléchargement pour Mac OS). Votre téléchargement va se 
lancer. 

3. Ouvrez et installez l’application de programmation ACP téléchargée :
• Windows : 

i. Localisez le fichier téléchargé.
ii. Cliquez sur le fichier extrait pour le lancer.
iii. Suivez les instructions pour installer l’application dans le dossier C:\Program Files.

• Mac OS : 
i. Localisez le fichier téléchargé.
ii. Glissez et déposez le fichier dans votre dossier Applications.
iii. Suivez les instructions pour installer l’application.

Application de programmation ACP 
Guide de l’utilisateur │écran tactile
Utilisez l’application de programmation ACP pour créer et organiser les 
informations des éléments de menu depuis votre ordinateur.

Mise en route :
1. Lancez l’application.

• Windows : Ouvrez « ACP Remote Programming Interface » depuis votre dossier Program Files ou le raccourci 
du menu Démarrer.

• Mac OS : Ouvrez le fichier « ACP_Application.app ».
2. Lancez un nouveau menu à partir de zéro (a), ou ouvrez un menu existant (b) :

a. Créez un menu : 
i. Cliquez sur « File » (Fichier), puis sur « New » (Nouveau). 
ii. Sélectionnez le modèle approprié.

b. Ouvrez un menu existant : 
i. Sélectionnez « File » (Fichier), puis « Open » (Ouvrir). 
ii. Accédez à l’emplacement de votre fichier de menu et ouvrez-le. 

2a 2b

http://acpsolutions.com/oven-programming/
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Modification des options d’utilisateur :
1. Pour modifier la langue par défaut, faites votre sélection parmi les options dans le menu déroulant supérieur droit.
2. Cliquez sur l’onglet User Options (Options de l’utilisateur) pour accéder à différents réglages personnalisables.

Remarque: La température définie dans la section User Options (Options de l’utilisateur) sera la valeur par défaut lorsque vous 
créerez un élément de menu.

Remarque: Le logo par défaut pour l’écran de veille est le logo ACP, Inc. Personnalisez-le et ajoutez votre propre logo en 
sélectionnant le bouton « Add Logo to Startup » (Ajouter un logo au démarrage).

Remarque: Si l’option « PIN code required » (Code PIN requis) est activée, le PIN choisi doit être un PIN numérique à 4 chiffres.

Personnalisation du logo de l’écran de démarrage:
1. Redimensionnez l’image voulue à 400 x 400 pixels et enregistrez-la au format PNG. 
2. Dans l’onglet User Options (Options de l’utilisateur), cliquez sur Add Logo to Startup (Ajouter le logo au démarrage).
3. Cliquez sur l’icône de dossier et naviguez jusqu'à l’emplacement de l’image. Sélectionnez Open (Ouvrir). 
4. Fermez la fenêtre « Custom Logo » (Logo personnalisé) pour enregistrer les modifications.
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Création d’un onglet de recettes
1. Cliquez sur le menu déroulant Tabs (Onglets) et sélectionnez le nombre d’onglets souhaités.
2. Pour personnaliser l’apparence de chaque onglet, cliquez sur l’onglet voulu.
3. Sélectionnez une des options suivantes :

a.  Saisissez votre texte personnalisé ou
b.  Sélectionnez une icône

4. Sélectionnez la coche verte pour enregistrer.

Création d’un dossier de recettes:
1. Sélectionnez l’onglet Menu. 
2. Cliquez sur New Folder (Nouveau dossier). 
3. Modifiez le nom du dossier et l’apparence dans le volet situé 

à droite.  
Pour supprimer un dossier, cliquez sur l’icône de poubelle 
orange.

4. Glissez et déposez des recettes dans le dossier.  
Double-cliquez sur l’icône du dossier pour accéder au 
contenu. 

1 2

Organisation des menus:
Vous pouvez ajouter et organiser les informations des recettes en créant des recettes, des dossiers et des onglets.  
Consultez les pages suivantes pour plus d’informations.

Exemple de contenu :
Onglet 1 : Menu du déjeuner Onglet 2 : Menu du dîner
 Dossier A : Sandwichs  Dossier A : Pizzas
  Recette 1 : Panini Reuben   Recette 1 : Pizza aux poivrons 
  Recette 2 : Panini Muffuletta   Recette 2 : Pizza au fromage
 Dossier B : Accompagnements  Dossier B : Fruits de mer
  Recette 1 : Frites   Recette 1 : Saumon
  Recette 2 : Légumes grillés   Recette 2 : Crevettes

Pour télécharger et visualiser des exemples de menus, rendez-vous sur acpsolutions.com/oven-programming/#menu-
examples.

http://acpsolutions.com/oven-programming/#menu-examples
http://acpsolutions.com/oven-programming/#menu-examples
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Personnalisation des images des recettes et des dossiers:
1. Cliquez sur l’icône de l’image pour choisir une image pour la recette ou le dossier. 
2. Sélectionnez une des options suivantes :

a. Onglet « Pictures » (Photos) pour afficher un assortiment d’images en stock et en sélectionner. 
b. Onglet « Icons » (Icônes) pour afficher un assortiment d’icônes graphiques et en sélectionner.
c. Onglet « Load Image » (Charger une image) pour charger une image personnalisée pour la recette.

Chargement d’une image* :
1. Redimensionnez l’image voulue à 380 x 223 pixels et enregistrez-la au format PNG.  

Veuillez noter que les 64 pixels du bas seront recouverts par du texte.
2. Sélectionnez l’icône de dossier pour charger l’image personnalisée (voir la Figure 2c ci-dessous).
3. Accédez à l’emplacement de l’image et sélectionnez « Open » (Ouvrir). 
4. Sélectionnez la coche verte pour enregistrer.

* Pour les chargements d’images personnalisées uniquement

2a 2b 2c

1

Création d’une recette:
1. Sélectionnez l’onglet Menu.
2. Cliquez sur New Recipe (Nouvelle recette).
3. Modifiez le nom du dossier, les paramètres et l’apparence dans le volet situé à droite.  

Pour supprimer une recette, cliquez sur l’icône de poubelle orange.

1
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Modification d’un dossier existant :
1. Sélectionnez « File » (Fichier), puis « Open » (Ouvrir). Accédez à l’emplacement de votre fichier de menu et ouvrez-le. 

2. Cliquez sur le dossier pour modifier la couleur, l’icône, l’image, le nom, etc.
3. Pour supprimer un dossier, sélectionnez l’icône de poubelle orange.
4. Pour enregistrer les modifications et créer un fichier mis à jour, sélectionnez « File » (Fichier), puis « Save As » (Enregistrer sous).

Modification d’une recette existante :
1. Ouvrez l’application de programmation ACP sur votre ordinateur.
2. Sélectionnez « File » (Fichier), puis « Open » (Ouvrir). Accédez à l’emplacement de votre fichier de menu et ouvrez-le.

3. Double-cliquez dessus pour ouvrir le dossier contenant la recette.
4. Cliquez sur une recette pour modifier le nom de la recette, l’image ou les paramètres de cuisson.
5. Pour supprimer une recette, sélectionnez l’icône de poubelle orange.
6. Pour enregistrer les modifications et créer un fichier mis à jour, sélectionnez « File » (Fichier), puis « Save As » (Enregistrer sous).

Création d’une recette:
1. Sélectionnez l’onglet Menu.
2. Cliquez sur New Recipe (Nouvelle recette).
3. Modifiez le nom du dossier, les paramètres et l’apparence dans le volet situé à droite.  

Pour supprimer une recette, cliquez sur l’icône de poubelle orange.
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Enregistrement des informations de menu:
Pour les modèles à écran tactile, les fichiers peuvent être transférés via une connexion USB, Wi-Fi ou Ethernet.  
Consultez ci-dessous les meilleures pratiques pour chaque méthode de transfert : 

USB
1. Sélectionnez « File » (Fichier), puis « Save As » (Enregistrer sous).
2. Naviguez jusqu’à la clé USB. 
3. Spécifiez un nom de fichier pour le nouveau menu. Cliquez sur « Save » (Enregistrer).
Remarque :  Les fichiers doivent être enregistrés dans le répertoire racine de la clé USB (ils ne peuvent pas être enregistrés à 

l’intérieur d’un autre dossier). 

Wi-Fi ou Ethernet
1. Sélectionnez « File » (Fichier), puis « Save As » (Enregistrer sous).
2. Naviguez jusqu'à l’emplacement désiré. 
3. Spécifiez un nom de fichier pour le nouveau menu. Cliquez sur « Save » (Enregistrer). 

Compréhension des formats des fichiers de menu :

ANCIENNE VERSION VERSION AMÉLIORÉE
Version de l’application de 
programmation ACP

Windows : Version de bureau 34 Windows : 2017.08.22
Mac OS : MAC_release10_04_2016 Mac OS : 2017.08.22

Firmware compatible four Versions ≤ 3.1.0 Versions > 3.1.1

Format de fichier de menu 
enregistré/exporté

Fo
rm

at
 d

e fi
ch

ier
 d

e m
en

u 
lis

ib
le

Via clé USB ou

Via Wi-Fi/Ethernet ou

Avez-vous un fichier de menu .mxp que vous souhaitez charger sur un four avec une version de firmware plus 
ancienne ?

 ● ACP recommande vivement la mise à jour du four vers la plus récente version du firmware.  
Rendez-vous sur acpsolutions.com/oven-programming/ pour en savoir plus et télécharger.  

 ● Si vous choisissez de continuer à utiliser l’ancienne version du firmware, vous pouvez revenir aux 
anciens formats des fichiers .mxp à l’aide de la méthode suivante :

1. Renommez le fichier .mxp : remplacez l’extension de fichier « .mxp » par « .zip ».
2. Extrayez ou décompressez le fichier renommé.

http://acpsolutions.com/oven-programming/
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Die ACP-Programmierapp-Version Versionsaktualisierungen vorbehalten.  
Verwenden Sie stets die aktuellsten Versionen, um das bestmögliche Benutzererlebnis zu garantieren.  
Nutzen Sie möglichst die aktuellste Version der Ofen-Firmware zu verwenden 
Weitere Informationen sowie die Möglichkeit zum Download finden Sie unter acpsolutions.com/oven-
programming/.

Herunterladen und Installation:
1. Öffnen Sie einen Internet-Browser und navigieren Sie zu acpsolutions.com/oven-programming/.  
2. Wählen Sie den entsprechenden Download für die ACP-Programmieranwendung aus.  

(Windows-Download oder Mac-OS-Download) Ihr Download beginnt. 
3. Öffnen und installieren Sie die heruntergeladene ACP-Programmieranwendung:

• Windows: 
i. Suchen Sie die heruntergeladene Datei.
ii. Klicken Sie auf die extrahierte Datei, um sie auszuführen.
iii. Befolgen Sie die Anweisungen zum Installieren der Anwendung im Verzeichnis C:\Programme

• Mac OS: 
i. Suchen Sie die heruntergeladene Datei .
ii. Legen Sie die Datei per Drag and Drop in Ihrem Ordner „Programme“ ab
iii. Befolgen Sie die Anweisungen zum Installieren der Anwendung

ACP-Programmieranwendung  
Benutzerhandbuch │Touchscreen
Erstellen und verwalten Sie mit der ACP-Programmieranwendung Menüelemente und 
deren Daten auf Ihrem Computer.

Erste Schritte:
1. Starten Sie die Anwendung

• Windows: Öffnen Sie die „ACP-Fernprogrammierschnittstelle“ im Ordner Programme oder über die Verknüpfung im 
Startmenü

• Mac OS: Öffnen Sie die Datei „ACP_Application.app“
2. Erstellen Sie ein neues Menü (a) oder öffnen Sie ein vorhandenes Menü (b):

a. Neues Menü erstellen: 
i. Klicken Sie auf „Datei“, dann auf „Neu“. 
ii. Wählen Sie das entsprechende Modell aus.

b. Vorhandenes Menü öffnen: 
i. Wählen Sie „Datei“, dann „Öffnen“. 
ii. Navigieren Sie zum Speicherort Ihrer Menü-Datei  und öffnen Sie die Datei. 

2a 2b

http://acpsolutions.com/oven-programming/
http://acpsolutions.com/oven-programming/
http://acpsolutions.com/oven-programming/
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Benutzeroptionen anpassen:
1. Über die Optionen im Dropdown-Menü oben rechts können Sie die Standardsprache ändern.
2. Klicken Sie auf die Registerkarte Benutzeroptionen, um eine Vielzahl von anpassbaren Einstellungen anzuzeigen.

Hinweis: Die im Abschnitt „Benutzeroptionen“ festgelegte Temperatur ist bei der Erstellung eines neuen Produkts die Standard-
Temperatur

Hinweis: Das standardmäßige Logo für den Standby-Bildschirm ist das Logo der ACP, Inc. Sie können es anpassen und Ihr 
eigenes Logo über die Schaltfläche „Logo für Startbildschirm hinzufügen“ einbauen.

Hinweis: Wenn die Option „PIN-Code erforderlich“ aktiviert ist, muss es sich bei der gewählten PIN um eine 4-stellige numerische 
PIN handeln.

Startbildschirm-Logo anpassen
1. Passen Sie die Größe des gewünschten Bildes auf 400 x 400 Pixel an und speichern Sie es im PNG-Format. 
2. Klicken Sie in der Registerkarte Benutzeroptionen auf Logo für Startbildschirm hinzufügen
3. Klicken Sie auf das Ordnersymbol und navigieren Sie zum Speicherort des Bildes. Klicken Sie auf „Öffnen“. 
4. Schließen Sie das Fenster „Benutzerdefiniertes Logo“, um die Änderungen zu speichern.

2
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Neue Rezept-Registerkarte erstellen
1. Klicken Sie auf das Dropdown-Menü Registerkarten und wählen Sie die gewünschte Anzahl an Registerkarten aus.
2. Um die Darstellung der einzelnen Registerkarten anzupassen, klicken Sie auf die Registerkarte.
3. Wählen Sie eine der folgenden Optionen aus:

a.  Geben Sie Ihren benutzerdefinierten Text  ein oder
b.  Wählen Sie ein Symbol aus

4. Wählen Sie dann zum Speichern das grüne Häkchen-Symbol aus.

Neuen Rezept-Ordner erstellen
1. Wählen Sie die Registerkarte Menü aus. 
2. Klicken Sie auf Neuer Ordner 
3. Bearbeiten Sie den Namen und die Darstellung des Ordners im Feld 

auf der rechten Seite.  
Um einen Ordner zu löschen, klicken Sie auf das orangefarbene 
Papierkorb-Symbol.

4. Verschieben Sie Rezepte per Drag and Drop in den Ordner.  
Klicken Sie doppelt auf das Ordner-Symbol, um auf die Inhalte im 
Ordner zuzugreifen. 

1 2

Menüs organisieren:
Sie können Rezeptinformationen hinzufügen und organisieren, indem Sie neue Rezepte, Ordner und Registerkarten erstellen.  
Auf den folgenden Seiten finden Sie weitere Informationen.

Beispiel-Inhalt
Registerkarte 1: Mittagsmenü Registerkarte 2: Abendmenü
 Ordner A: Sandwiches  Ordner A: Pizza
  Rezept 1: Reuben-Panini   Rezept 1: Salamipizza 
  Rezept 2: Muffuletta-Panini   Rezept 2: Käsepizza
 Ordner B: Beilagen  Ordner B: Meeresfrüchte
  Rezept 1: Pommes frites   Rezept 1: Lachs
  Rezept 2: Gebratenes Gemüse   Rezept 2: Garnelen

Um Beispielmenüs herunterzuladen und anzuzeigen, besuchen Sie bitte  
acpsolutions.com/oven-programming/#menu-examples

http://acpsolutions.com/oven-programming/#menu-examples
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Bilder für Rezept und Ordner anpassen
1. Klicken Sie auf das Bild-Symbol, um ein Bild für das Rezept bzw. den Ordner auszuwählen. 
2. Wählen Sie eine der folgenden Optionen aus:

a. Die Registerkarte „Bilder“, um eine Auswahl an Archivbildern anzuzeigen, aus denen Sie wählen können. 
b. Die Registerkarte „Symbole“, um eine Auswahl an Grafik-Symbolen anzuzeigen, aus denen Sie wählen können
c. Die Registerkarte „Bild hochladen“, um ein benutzerdefiniertes Bild für das Rezept hochzuladen.

Ein Bild hochladen*:
1. Passen Sie die Größe des gewünschten Bildes auf 380 x 223 Pixel an und speichern Sie es im PNG-Format.  

Bitte beachten Sie, dass die unteren 64 Pixel von Text verdeckt werden.
2. Wählen Sie das Ordnersymbol aus, um das benutzerdefinierte Bild hochzuladen. (siehe Abb. 2c unten)
3. Navigieren Sie zum Speicherort des Bildes und wählen Sie „Öffnen“ aus. 
4. Wählen Sie dann zum Speichern das grüne Häkchen-Symbol aus.

*Nur für das Hochladen benutzerdefinierter Bilder

2a 2b 2c

1

Neues Rezept erstellen:
1. Wählen Sie die Registerkarte Menü aus.
2. Klicken Sie auf Neues Rezept
3. Bearbeiten Sie den Namen, die Einstellungen sowie die Darstellung des Rezepts im Feld auf der rechten Seite.  

Um ein Rezept zu löschen, klicken Sie auf das orangefarbene Papierkorb-Symbol.

1

2 3
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Einen vorhandenen Ordner bearbeiten
1. Wählen Sie „Datei“, dann „Öffnen“. Navigieren Sie zum Speicherort Ihrer Menü-Datei und öffnen Sie die Datei.

2. Klicken Sie auf den Ordner, um die Farbe, das Symbol, das Bild, den Namen usw. zu bearbeiten.
3. Um einen Ordner zu löschen, wählen Sie das orangefarbene Papierkorb-Symbol aus.
4. Um die Änderungen zu speichern und eine neue aktualisierte Datei zu erstellen, wählen Sie „Datei“ und anschließend „Speichern 

unter“ aus.

Ein vorhandenes Rezept bearbeiten
1. Öffnen Sie die ACP-Programmieranwendung auf Ihrem Computer.
2. Wählen Sie „Datei“, dann „Öffnen“. Navigieren Sie zum Speicherort Ihrer Menü-Datei und öffnen Sie die Datei.

3. Klicken Sie doppelt auf den Ordner mit dem Rezept.
4. Klicken Sie auf ein Rezept, um den Namen, das Bild oder die Kocheinstellungen für das Rezept zu bearbeiten.
5. Um ein Rezept zu löschen, wählen Sie das orangefarbene Papierkorb-Symbol aus.
6. Um die Änderungen zu speichern und eine neue aktualisierte Datei zu erstellen, wählen Sie „Datei“ und anschließend „Speichern 

unter“ aus.

Neues Rezept erstellen:
1. Wählen Sie die Registerkarte Menü aus.
2. Klicken Sie auf Neues Rezept
3. Bearbeiten Sie den Namen, die Einstellungen sowie die Darstellung des Rezepts im Feld auf der rechten Seite.  

Um ein Rezept zu löschen, klicken Sie auf das orangefarbene Papierkorb-Symbol.
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Menüinformationen speichern
Bei den Touchscreen-Modellen können Dateien über USB, WLAN oder Ethernet-Verbindungen übertragen werden. 
Untenstehend finden Sie bewährte Vorgehensweisen für die einzelnen Übertragungswege: 

USB
1. Wählen Sie „Datei“, dann „Speichern unter“.
2. Navigieren Sie zum USB-Stick. 
3. Geben Sie einen Dateinamen für das neue Menü ein. Klicken Sie auf „Speichern“.
Hinweis:  Die Dateien müssen im Stammverzeichnis des USB-Sticks gespeichert werden (sie dürfen also nicht in einem anderen 

Ordner gespeichert werden). 

WLAN oder Ethernet
1. Wählen Sie „Datei“, dann „Speichern unter“.
2. Navigieren Sie zum gewünschten Speicherort. 
3. Geben Sie einen Dateinamen für das neue Menü ein. Klicken Sie auf „Speichern“. 

Die Menüdatei-Formate verstehen

ÄLTERE VERSION OPTIMIERTE VERSION
ACP-Programmieranwendung – 
Version

Windows: Desktop-Version 34 Windows: 2017.08.22
Mac OS: MAC_release10_04_2016 Mac OS: 2017.08.22

Kompatible Ofen-Firmware Versionen ≤ 3.1.0 Versionen > 3.1.1

Gespeichertes/exportiertes Menü-
Datei-Format

Le
sb
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at

Über USB-Stick oder

Über WLAN/Ethernet oder

Haben Sie eine Menüdatei im .mxp-Format, die Sie auf einem Ofen mit einer älteren Firmwareversion hochladen 
möchten?

 ● ACP empfiehlt dringend, den Ofen auf die aktuellste und beste Firmwareversion  
zu aktualisieren.  
Besuchen Sie acpsolutions.com/oven-programming/ für weitere Informationen sowie Möglichkeiten  
zum Download.  

 ● Wenn Sie weiterhin die ältere Version der Firmware verwenden, können Sie .mxp-Dateien mit der folgenden Methode 
in das veraltete Format umwandeln:

1. Benennen Sie die .mxp-Datei um: ersetzen Sie die Dateiendung „.mxp“ durch „.zip“
2. Extrahieren oder entpacken Sie die umbenannte Datei

http://acpsolutions.com/oven-programming/
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La versione dell’app di programmazione ACP è soggetta a modifiche.  
Utilizzare la versione più recente, quando è disponibile.  
Per risultati ottimali, utilizzare in combinazione con l’ultima versione del firmware del forno. 
Per scaricare gli aggiornamenti del firmware e le istruzioni di installazione visitare acpsolutions.com/oven-
programming/

Scaricare e installare:
1. Aprire il browser internet e andare all’indirizzo acpsolutions.com/oven-programming/  
2. Selezionare il download per l’applicazione di programmazione ACP corretto.  

(Download Windows o Download Mac OS) Il download verrà avviato. 
3. Aprire e installare l’applicazione di programmazione ACP scaricata:

• Windows: 
i. Individuare il file scaricato.
ii. Fare clic per avviare il file estratto.
iii. Seguire le istruzioni visualizzate per installare l’applicazione nella cartella C:\Program Files

• Mac OS: 
i. Individuare il file scaricato.
ii. Trascinare e rilasciare nella cartella “Applicazioni”
iii. Seguire le istruzioni visualizzate per installare l’applicazione.

Applicazione di programmazione ACP 
Touchscreen │Guida per l’utente
Utilizzare dell ’applicazione di programmazione ACP per creare e organizzare le 
informazioni sulle voci di menu dal proprio computer.

Guida introduttiva:
1. Lanciare l’applicazione:

• Windows: Aprire “Interfaccia di programmazione remota ACP” dalla cartella Program Files o dal collegamento del menu 
“Start”

• Mac OS: Aprire il file “ACP_Application.app”
2. Creare un nuovo menu da zero (a), o Aprire un menu esistente (b):

a. Creare un nuovo menu: 
i. Fare clic su “File”, quindi su “Nuovo”. 
ii. Selezionare il modello corrispondente.

b. Aprire il menu esistente: 
i. Selezionare “File”, quindi “Apri”. 
ii. Passare al menu File e aprirlo.. 

2a 2b

*La versione dell’app di programmazione ACP è soggetta a modifiche.  
Utilizzare la versione più recente, quando è disponibile.  
Per risultati ottimali, utilizzare in combinazione con l’ultima versione del firmware del forno. 
Per scaricare gli aggiornamenti del firmware e le istruzioni di installazione visitare acpsolutions.com/oven-programming/

http://acpsolutions.com/oven-programming/
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Modificare le opzioni utente:
1. Per modificare la lingua predefinita, selezionarla dalle opzioni nel menu a tendina in alto a destra.
2. Fare clic sulla scheda Opzioni utente per accedere alle diverse impostazioni personalizzabili.

Nota: Quando si crea una nuova voce di menu, la temperatura impostata nella sezione Opzioni utente avrà un valore predefinito.

Nota: Il logo predefinito per la schermata di standby è il logo ACP, Inc. Selezionando il pulsante “Aggiungi logo all’avvio”, è 
possibile personalizzare e aggiungere il proprio logo.

Nota: Se l’opzione “codice PIN richiesto” è abilitata, il PIN scelto deve essere un PIN numerico di 4 cifre.

Personalizzare il logo della schermata di avvio
1. Ridimensionare l’immagine desiderata a 400 x 400 pixel e salvarla in formato PNG. 
2. Sulla scheda Opzioni utente, fare clic su Aggiungere logo all’avvio
3. Fare clic sull’icona della cartella e passare alla posizione dell’immagine. Selezionare Apri. 
4. Chiudere la finestra “Logo personalizzato” per salvare le modifiche.

2
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Creare una nuova scheda ricetta
1. Fare clic sulle schede del menu a tendina e selezionare il numero di schede desiderato.
2. Per personalizzare l’aspetto di ciascuna scheda, fare clic sulla scheda.
3. Selezionare una delle seguenti opzioni:

a.  Digitare un testo personalizzato o
b.  Selezionare un’icona

4. Selezionare il segno di spunta verde per salvare.

Creare una nuova cartella ricetta
1. Selezionare la scheda Menu. 
2. Fare clic su Nuova cartella 
3. Modificare il nome e l’aspetto della cartella nel pannello a 

destra.  
Per eliminare una cartella, fare clic sull’icona del cestino 
arancione.

4. Trascinare e rilasciare le ricette nella cartella.  
Fare doppio clic sull’icona della cartella per accedere ai 
contenuti. 

1 2

Organizzare i menu:
È possibile aggiungere e organizzare le informazioni sulle ricette, creando nuove ricette, cartelle e schede.  
Vedere le pagine seguenti per ulteriori informazioni.

Esempio di contenuto: 
Scheda 1: Menu per il pranzo Scheda 2: Menu per la cena
 Cartella A: Panini  Cartella A: Pizza
  Ricetta 1: Panino Reuben   Ricetta 1: Pizza con salame piccante 
  Ricetta 2: Panino Muffuletta   Ricetta 2: Pizza al formaggio
 Cartella B: Contorni  Cartella B: Frutti di mare
  Ricetta 1: Patatine fritte   Ricetta 1: Salmone
  Ricetta 2: Verdure arrostite   Ricetta 2: Gamberetti

Per scaricare e visualizzare i menu di esempio, visitare  
acpsolutions.com/oven-programming/#menu-examples

http://acpsolutions.com/oven-programming/#menu-examples
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Personalizzare le immagini della ricetta e della cartella
1. Fare clic sull’icona dell’immagine per scegliere un’immagine per la ricetta o la cartella. 
2. Selezionare una delle seguenti opzioni:

a. “Foto”, scheda per visualizzare e scegliere tra un assortimento di immagini disponibili. 
b. “Icone”, scheda per visualizzare e scegliere tra un assortimento di icone grafiche.
c. “Carica Immagine”, scheda per caricare un’immagine personalizzata per la ricetta.

Caricare un’immagine*:
1. Ridimensionare l’immagine desiderata a 380 x 223 pixel e salvarla in formato PNG.  

Si prega di notare che i 64 pixel della parte inferiore verranno coperti dal testo.
2. Selezionare l’icona della cartella per caricare l’immagine personalizzata. (Vedere figura 2c sotto)
3. Passare alla posizione dell’immagine e selezionare “Apri”. 
4. Selezionare il segno di spunta verde per salvare.

*Solo per il caricamento di immagini personalizzate

2a 2b 2c

1

Creare una nuova ricetta:
1. Selezionare la scheda Menu.
2. Fare clic su Nuova ricetta
3. Modificare il nome, le impostazioni e l’aspetto della ricetta nel pannello a destra.  

Per eliminare una ricetta, fare clic sull’icona del cestino arancione.

1

2 3
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Modificare una cartella esistente
1. Selezionare “File”, quindi “Apri”. Passare al menu File e aprirlo.

2. Fare clic sulla cartella per modificarne colore, icona, immagine, nome, ecc.
3. Per eliminare una cartella, selezionare l’icona del cestino arancione.
4. Per salvare le modifiche e creare un nuovo file aggiornato, selezionare “File”, quindi “Salva con nome”.

Modificare una ricetta esistente
1. Aprire l’applicazione di programmazione ACP dal computer.
2. Selezionare “File”, quindi “Apri”. Passare al menu File e aprirlo.

3. Fare doppio clic per aprire la cartella contenente la ricetta.
4. Fare clic su una ricetta per modificarne il nome, l’immagine o le impostazioni di cottura.
5. Per eliminare una ricetta, selezionare l’icona del cestino arancione.
6. Per salvare le modifiche e creare un nuovo file aggiornato, selezionare “File”, quindi “Salva con nome”.

Creare una nuova ricetta:
1. Selezionare la scheda Menu.
2. Fare clic su Nuova ricetta
3. Modificare il nome, le impostazioni e l’aspetto della ricetta nel pannello a destra.  

Per eliminare una ricetta, fare clic sull’icona del cestino arancione.
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Salvare le informazioni del menu
Per i modelli touchscreen, i file possono essere trasferiti tramite USB, connessione Wi-Fi o Ethernet.  
Vedere di seguito le procedure consigliate per ciascun metodo di trasferimento: 

USB
1. Selezionare “File”, quindi “Salva come”.
2. Accedere al contenuto dell’unità USB. 
3. Specificare un Nome file per il nuovo menu. Fare clic su “Salva”.
Nota:  I file devono essere salvati nella directory principale dell’unità USB (non possono essere salvati all’interno di un’altra 

cartella). 

Wi-Fi o Ethernet
1. Selezionare “File”, quindi “Salva come”.
2. Passare alla posizione desiderata. 
3. Specificare un Nome file per il nuovo menu. Fare clic su “Salva”. 

Comprendere i formati del menu File

VERSIONE LEGACY VERSIONE MIGLIORATA
Versione app di programmazione 
ACP

Windows: Versione desktop 34 Windows: 2017.08.22
Mac OS: MAC_release10_04_2016 Mac OS: 2017.08.22

Firmware compatibile con il forno Versioni ≤ 3.1.0 Versioni > 3.1.1

Formato file di menu salvato/
esportato

Fo
rm

at
o 

fil
e d

i m
en

u 
leg

gi
bi

le

Tramite unità USB o

Tramite Wi-Fi/Ethernet o

C’è un menu File .mxp che si desidera caricare su un forno con una versione precedente del firmware?

 ● ACP consiglia vivamente di aggiornare il forno alla più recente versione del firmware.  
Visitare acpsolutions.com/oven-programming/ per saperne di più e procedere al download.  

 ● Se si sceglie di continuare a utilizzare la versione precedente del firmware, si possono ripristinare i file 
.mxp al formato legacy utilizzando il seguente metodo:

1. Rinominare il file .mxp: sostituire l’estensione del file “.mxp” con “.zip”
2. Estrarre o decomprimere il file rinominato

http://acpsolutions.com/oven-programming/
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